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Asset Creation Guidelines

This document is intended to bring together all the information that currently exists on how to make assets that work best in our game.  These are guidelines only - there will often be cases when you will want to do things slightly differently than what is suggested here, and you are encouraged to do so.  Use this document as your reference point, however, so that you understand the tradeoffs to be made.

First, print out or otherwise make a copy of the Quick Reference sheet - if you trim down the paper, you should be able to tape it beside your monitor's screen, or some other convenient place near your computer.   Next, read Part II of the document (Making Objects).  This is an overview of the sorts of things you want to think about and do in order to make a really successful object.  Finally, there are explanations for all the checklist entries, and a technical appendix which has some information about various tools and concepts you will be using during object creation.
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Asset Checklist

Ignore italicized items for now

The Golden Rule:

Objects included in the game
should do what they are most
known for doing in reality.

Initial considerations (pg. 4):
1. Build objects which
are simulateable well

2. Do not use recognizable
brands

3. Build for breakability/ 
moveability 

4. Make object actual size

5. Minimize transparency

6. Eliminate garbage pixels 
in transparent maps

7. Minimize polygon count

8. Split or combine objects  

9. Buildings: boarded 
windows, no tight spaces

10. Be aware of issues with text


Final steps (pg. 6):
1. Reapply UVW coords after 
moving vertices

2. Check colors against other 
similar objects

3. Center pivot point to object

4. Evaluate texture sizes/usage

5. Clear object names 

6. Good map paths

7. Text properties

Export object (pg. 7):
1. Correct export position/ 
orientation/scale

2. Good bounding box 

3. No texture errors

4. No missing faces

5. No internal clipping

6. Good bumpmapping 
and smoothing

7. Power of 2 maps, 
Consult mip-mapping log

8. Quick test magnets/ 
physics definitions

Asset Guidelines, Part II: Making Objects

Always use GUIApp

GUIApp is our game, so there is nothing more important than using it all through the creation of your object. GUIApp is actually a better and faster renderer than 3D Studio MAX for showing objects using the features we support, and you should take advantage of its speed, and of its various technical reports and views which give you information that MAX can't.  See the Using GUIApp and Using the Groff Exporter appendix entries for details.

Test your object in a scene

Beyond just loading your object on its own in GUIApp, it is very important to load it into a representational scene from your area.  There are several ways to go about this, from loading a pre-created scene and adding your object to making the scene yourself.  Any way you do it, the best way to really understand how your object works in the game, visually, physically and in terms of speed, is to put it with a bunch of other objects in an actual game scene.

Understand your Object

The key to all the decisions you will make while building your objects is to have a thorough understanding of just how your object fits into the game.  This affects everything from how polygonally simple or complex you decide to make it to how it gets defined physically.  If your object is something which gets used repeatedly or which the user spends a lot of time in or around, or fighting near, such as a piece of vegetation, a crate, or a building, then you will want to consider optimizing it for speed and memory.  If it is a one-off object like an old piece of Mayan sculpture, or something which the user will pick up and hold in front of their face like a gun, hammer, or club, then you could consider making it more detailed to be as visually pleasing as possible.

Understand Physics

Read The Solids Model in the appendix.  It is crucial you understand how we make our objects physical so that you can make your geometry work with physics.  Furthermore, since physics will be defined through object text properties in MAX, you will actually be able to completely control how your object works physically.  This is very easy and a lot of fun, and you should be able to take care of most of the physical requirements for an object on your own.

The Golden Rule

Many of your questions about how to construct an object, especially for physics, can be answered just by considering the question "What would the player most expect this object to do in reality?"  This question and an understanding of the features of our game should guide all your choices of object construction.  If you are planning a piece of upholstered furniture, for instance, the answer might be "the cushions should flex."  At this point, understanding that the solids model is better suited to representing rigid objects, you might consider reducing the piece of furniture to its frame - perhaps its been exposed to the weather for the nine years which have elapsed since the island was abandoned.  Alternatively, it might be remotely possible to make the cushions seem flexible by doing something clever such as modeling the object with the bio-model instead of the solids model, but this could cause complications in building the model and probably be slower than a solids modeled object.  It is your job to decide which is the best use of the features of our game.

Talk to the Designers and Engineers

The technology and design of the game is constantly evolving.  You will no doubt have many questions about what an object is intended to do, or how to do certain things with an object you are designing.  Keep in constant contact with the rest of the team to stay abreast of the progress of features, and to get the information you need to create your asset.  Be aware of the gameplay purpose of your object, both through reading the related design documentation (see the appendix for details) and talking with the designers to get the latest word about the state of puzzles.

Asset Guidelines, Part III: Checklist Explanations

Initial Considerations for Asset Building

1)  Build objects which can be simulated realistically and interestingly.

Use the Golden Rule on your objects, and if there seems to be something that the object should do which you can't think of a good way to simulate in the game, consider changing the object. 

2) Do not use recognizable brands

We need legal clearance to use any existing brand or recognizable object.  In many cases, changing the logos will suffice, but if you are using photoreference for some particularly distinctive piece of equipment (like an airplane, vehicle, or perhaps even tool), then change a few physical details as well to avoid legal complications.  There are some exceptions: we can use all the vehicles which appeared in the film, we have clearance to use Coke, and we're seeking clearance for the Cray X-MP supercomputer and as many as the guns from Terry's gun list as possible.  We can try to get clearance for other brands, so if you think there is a very good reason to have some identifiable type of object, we can look into it, but it is preferable to make up something.

3) Build your object to be breakable and to have moving parts

Understand the solids model and bio-model so that you can make the geometry of your object work well with the physics system.  Assets which can come apart or move need to be made out of separate, non-intersecting objects, just like in the real world.  For the most part, gameplay-critical objects have moveability and breakability specified in their object description, but if you are creating additional objects, and have questions, consult the designers.  In most cases, if the object could be broken in the real world by human action (including having other heavy objects dropped on it), it needs to be breakable.  If it is a pretty sturdy object such as a small shed, but it is in an area where large dinosaurs might be interacting with it, then it also needs to be breakable.  Our large structures should be unbreakable, although they could have parts, such as awnings or balconies, which break off.  In certain cases though, especially the plantation house, we will make as much of the entire structure breakable as seems possible, and send in a big dinosaur to tear it to pieces.

4) Make object actual size

You must set your system units in MAX to 1m.  To check this in MAX, you can go to File/Preferences in the drop-down menu and choose the General tab.  Then, in the "System Unit Scale" section, make sure it reads "1 Unit = 1.0 Meters".  This is not to be confused with the Units setup you get when you select Views/Units Setup... from the drop-down list.  The settings you specify there are what MAX shows you in it's various spinners, etc - you can have MAX display in feet and inches instead of meters if you prefer (though the design docs are all specified in metric), as long as you are working with units set to 1m.  Make sure you use the tape tool to measure your object and ensure that it is the same size as it would be in the real world before you export it.

5) Minimize transparency

We're doing well with this already, so this entry is more of an explanation than a guideline: overlapping transparency is one of the slowest cases for us to render.  Transparency is a good way to reduce polygon count, but the more layers of transparency the game has to draw and the more screen that transparency covers, the slower it will go.  Check your object in GUIApp by turning off Transparency (under Options>Textures) and get a sense of how much transparency that object reveals when you are looking at it in the ways the player will most frequently look at it.  It is also important to understand that it's not the area of the texture map that is transparent, but the area of the screen that is rendered transparent.  So, for example, if you create a very small object like a flower, it's likely that it won't ever fill up much of the screen, and thus, it's not as big a concern for transparency.  But on the other hand, if you create a small tree that has branches at or about eye level, the transparency is much more of an issue because it's likely to fill much or all of the screen if you're standing close to it.

6) Avoid garbage pixels in transparent maps

Vegetation leaves and other maps which use transparency look completely unrealistic when there are pixels around their edges which are black, partially aliased to black, or some other unusual color.  To avoid this, try to paint on a color common to your map colors, and be sure to carefully check how your opacity map covers your texture map in Photoshop.

7) Minimize polygon count

We're optimizing fairly efficiently here, but there are a few issues to be aware of.  One is: GUIApp  combines triangles into larger polygons whenever possible.   A box, for instance, which is 12 faces in MAX, will actually be 6 faces in GUIApp.  Get your polygon count from GUIApp by loading your object and double left clicking on its crosshair.  See 1) from Final Steps below for some polygon joining trouble you can run into with texture mapping.  Another issue is that polygon count should depend on the use of the object: if it is a commonly occurring object, or an object with a lot of pieces, then you will probably want to make the polygon count a little lower than usual.  If it is a rarely occurring or unique object, especially if it sits in a part of the world where no fighting occurs or where we can keep other objects away from it, then you might want to go a little more complex.  Similarly, important handheld objects like guns and hammers might be a little more complicated than unimportant things like sticks and stones, because the player will be spending some time watching these objects move around right in front of their face.

8) Split or combine objects for efficient handling by game systems

Depending on an asset's use in the game, you may want to split it into several smaller objects, or you may want to attach smaller objects into much larger objects.  Very long, static objects, such as the walls of the town or the monorail track should be built in long sections in order to minimize their interaction with the image cache, but other objects such as trees may possibly run faster if their tops are made as separate pieces from their bottoms.  As the image cacheing system gets developed further, more information will become available about how objects should best be constructed.  

Note that the test for speed and efficiency on trees or other objects that are used frequently in an environment is to use an orchard situation.  See the appendix "Creating an orchard" below for an example of this.  If you find that an orchard of your trees is not rendering particulary quickly with image cacheing turned on, you may need to explore splitting them.

9) Buildings need to have most of their windows boarded over and few spaces narrower than 2m

Occlusion planes are invisible planes we can place anywhere which tell the renderer not to render whatever is on the other side of the plane.  We are going to place these in the walls of buildings and other static objects to allow the renderer to draw inside of buildings at at the highest possible framerate by ignoring all the trees on the outside.  The larger the occlusion plane is, the better, and this will have a few consequences for our architecture.  In order to make the largest possible planes, most of all the windows in our buildings should be boarded over (with no cracks to see through whatsoever) or otherwise permanently shut, and we need to make it clear to the player that she's not getting the boards off, either.  Terry's sketch of Hammond's house is a pretty good illustration of this.

The 2m recommended minimum size of an area is intended to allow us to avoid running a lot of physics on objects which are on the other side of a wall from you.  The basic rule here is that all objects near a bio-model such as Anne or a dinosaur get looked at by the physics system, and the more objects there are, the slower everything goes.  If Anne is in a tight closet with shelves and dozens of objects on the shelves, then even if everything is sitting still, the physics system has to constantly process all the objects, just in case any of them need to get moved.  Furthermore, if there is a shelf and objects just on the other side of a wall that Anne is standing near, they also get evaluated.  The more speed we need inside a building to support fighting or other action sequences, the more open and sparse the rooms should be.  Buildings which will be pure exploration zones can have more objects and tighter corridors.

10) Text in art 


It is pretty much a given that many people who play this game will play at 320x200, or 320x240.  At this resolution, it becomes almost impossible to read all the detail on a max-size texture (256x256) unless the player gets so close that it is nearly filling the screen.  Design is attempting to keep game-critical signs to a minimum, and is planning game-critical text to be in as large a typeface as possible (given how big the text might actually be in the real world).  For non game-critical text you would like to include, keep in mind that any high detail text you put into objects will be a blur to players on average machines unless they get very close to it - if you are including the text for atmosphere (such as warning signs and the like), one large-print word may work as well as several smaller ones.  However, if reading the text is unimportant, then small type will be fine, and players who can run in higher resolution will be able to read it.  You should remember to save your original texture as a Photoshop document with the text in separate layers to ease the process of  localization, and double check your spelling before you submit the asset.

Final Steps of Object Building

1) If you move vertices, you should reapply your UVW map


Our renderer can only combine adjacent triangles into larger polygons if they are coplanar (see the appendix entry Coplanar Faces), and have linear UVW Mapping Coordinates.  UVW coordinates can become nonlinear when you move vertices around.  This also occurs with cylindrical mapping of non-cylindrical objects, which means, for instance, that most of our trees have as many polygons as they have triangles.  (This is more an example than a suggestion: optimizing every tree to have a perfectly cylindrical trunk would not be very visually pleasing.  However, if sections of trunk can be made cylindrical, some polygon reduction could be achieved, and other cylindrical objects should be regular if possible).  Occasionally, GUIApp mapping problems also result from moving vertices after mapping.  Whenever it is possible to reapply the coordinates after moving vertices without compromising the visual quality of the object, it should be done.  In addition, ensure that large flat areas such as walls of buildings or edges of long beams are really flat.

[image: image1.png]


Both sets of faces are flat with respect to the viewer, but a vertex in the right hand set has been shifted, warping the texture map.  Although these faces are coplanar, they can  no longer be reduced to a single polygon because their UVW coordinates are now nonlinear.

2) Check colors against other similar objects

In order to further the goal of realism, we need to have consistency across the colors used in trees and plants that belong in a single area.  In GUIApp, compare your tree or vegetation to the other vegetation in the area you are working on and consult with other artists working in your area to help maintain this consistency.  The same applies to other types of objects as well - lots of different objects from the asset lists are made of similar materials, and we need those materials to seem as consistent as the vegetation.

3) Center pivot point to object

Until further notice, it is important to center their pivot points to get them to export correctly.  Remember to check this as a last step - go into the Hierarchy panel, click "Affect Pivot Only" and then click "Center to Object" to fix them for your currently selected object(s); the Trespasser Utilities script (see Using Scripts in the appendix) has a button to take care of it in a few less clicks, as well.

4) Evaluate texture sizes and appropriate usage

On repeated and large objects, use smallest possible texture size, maintain 20-32 ppm, and tile if possible.

The smaller the texture you can use the better, for memory.  In a lot of cases, the highest resolution version of your texture often won't be seen, because our mip-mapping system automatically switches to a lower res version when the object gets a certain distance away from the player  (see Mip-mapping in the appendix).   On the other hand, having wildly different texture resolutions from one object to another means the world seems inconsistent, and therefore more like a computer rendering and less like a real world.  Tile textures whenever possible, and we recommend that frequently used objects or large objects like structures are mapped such that they have between 20 and 32 pixels per meter (that’s 3 to 5 cm per pixel).

On important and handheld objects, use greater than 32ppm.

Objects which Anne holds, guns especially, can and should have higher res textures, however - we want these to look very good while she is holding them, because this is about as close to the camera as any object will usually get, and they'll be there for a while so the player will have plenty of time to study them.  Parts of objects which need higher detail, such as signs, keypads, and dials, can also be mapped to a higher resolution.

Bumpmap curved objects always and moveable objects often.

The usage of bumpmaps needs to be considered carefully, as well. Bumpmaps are a primary feature of our game, but their use needs to be considered carefully.  Anything that would be round in the real world, from a tree trunk to a gun barrel, absolutely needs to have a bump map in order to appear curved in the game.  Flat, static objects, however, such as building walls, other large structures and any objects which are absolutely immovable may not actually need to be bumpmapped - in most cases you can get the same effect from painting shadows into the object.  It is also possible to make the static object with a bumpmap as you would normally, and then use MAX to light the texture using the bumpmap, and pull a new, non-bumpmapped version of the texture which is lit from the same direction as the rest of the world.  For now, continue to bumpmap non-curved static objects if you want to, and when we pick a final position for the world light, we will issue new instructions about pulling pre-lit texture maps for static objects if it seems like a memory and speed gain.

Besides cylindrical objects, things which are moveable and which have interesting detail on them, like carved wooden cabinets, metal objects with small bolts, etc, should almost certainly have some bumpmapping on them.  When Anne starts knocking these objects about, the bumpmapped details such as the carvings or bolts will really stand out and look fantastic.

In reference to the long-standing smearing problem with certain types of mapping: The problem with having to align cylindrical mapping coordinates to a polygon edge has been fixed.  You no longer have to do this - it should work no matter where the green line on your UVW Map Modifier gizmo is positioned.  

Apply UVW coordinates on static objects in same orientation as the world.

Buildings and other static objects will render as much as twice as fast if the UVW maps on their sides are oriented such that the pointer on the UVW Map gizmo points up – if you have mapped any building parts (walls especially) with the gizmo oriented sideways, it should be rotated 90 degrees.

5) Name objects clearly and ensure that all objects in a file are named.

All objects within your MAX file must have unique and easily understandable names.  It is important that anyone be able to tell what the object is by reading its object name, which should both say something general about the object and something specific about it.  For example, if you made three different sizes of rocks, you might want to consider names like PRock_half_m-00, PRock_quarter_m-00, and PRock_m-00.  Don't forget to give every object in your file a name which conforms to our naming conventions (P for Prop, V for Vegetation, -00 suffix to indicate instancing).  It is actually more important that the objects within your file be named clearly than the file itself, because our MAX select-by-name lists in our scenes will have hundreds of object and we need to be able to distinguish individual objects in these lists easily, rather than trying to hunt them down visually.  Feel free to use as many characters as needed to clearly say what the object is.

5.5) Do not change name of MAX file when resubmitting without making a note in the logfile

Whenever you change the name of your MAX file when you are working on an asset (by saving out a new version, for instance) you change the name of the asset for asset tracking purposes.  All assets are stored as MAX files in the appropriate K:\Art directories, and they are tracked on their MAX file name in the buglists and the asset lists.  Assets are the entire MAX file, not just the objects within it!
If you must change the name of the MAX file and resubmit, you also must inform the asset team by stating in your logfile the OLD name of the asset.  

Example:  You submit P_aChair.MAX.  You get some bugs on it, and change it a lot, so you want to save it as P_aChair01 while you are working on it just in case something goes wrong.  When you are done fixing it and go to resubmit, use the logfile comment line in the submission script to say: "Replaces  P_aChair.MAX."

6) Check map paths before and after submission

You should also check your texture map paths frequently because MAX makes some changes behind the scenes which can occasionally make your file point to maps in a place that no-one but you can get to.  There are two scripts which can help you, which are explained in more detail in the Using Scripts section of the Appendix.  One is Map Info, which can tell you where MAX is currently looking for textures for all the objects in your scene, and the other is Map Path Re-mapper, which you can use to change the directory MAX wants to look in for the maps.

Similarly, if you have to fix an object and you do the fixes to texture maps locally, be sure that you resubmit the object, and then load the file from the asset directory and check to be sure that it is getting the correct texture maps.

7) Text properties

(This section is temporary until Text Properties are up and running)

All objects that you create are going to have their non-geometric properties specified through the text box you get when you look at an object's properties in MAX.  There will be scripts which fill in default properties here, and if you know an object has specific requirements (mass, movability, special rendering options such as specularity or alpha channel, etc) you can enter them during object creation.

Exporting your Object

1) Make sure your object exports in the right spot and orientation

Throughout the construction of your objects, you should be exporting and testing them in GUIApp.  The current release of GUIApp (the shortcut Steve Barger distributes) always works.  Resolve any loading problems your object has, and once it is in GUIApp, check to be sure that it is in the correct position, orientation and scale.  Certain operations in MAX can cause your object to export strangely.  No asset should ever be submitted until you have made sure it exports correctly!  Read the appendix entries on Using the Exporter and Using GUIApp and if you have problems you can't resolve, consult someone for technical help.

There is now a groff file you can load from K:\Art\CommonGroffs called grid.grf which has X,Y, and Z axes marked in half meter intervals which should be useful in determining whether your object is exporting in the correct position and scale.

2) Good bounding box

Turn on Bones from the View menu in GUIApp - this will draw wireframe boxes around all your objects.  If the box doesn't match the bounding box in MAX or doesn't tightly fit the geometry, first check your pivot point, and then, if necessary, do a Reset Transform on your object.  

3) Check for texture errors and good looking maps

Inspect your object at some length in GUIApp be sure there aren’t any odd effects such as streaking.  These are usually caused by UVW mapping problems.  If it is an object that the player holds, such as a gun, try to position it in the orientation they are likely to hold it and bring it very close to the camera, to be sure it looks as good as possible from that perspective.

4) Check for missing faces

Unless your object is supposed to be immovable, it must have faces on all sides.  Basically, only trees (and not even all trees), most structures, and certain natural objects like huge boulders and stumps are immovable.  Check with the designers if you aren't sure.  Once you are sure all the sides of the object have faces, carefully rotate your object around to be sure you don't see any gaps or other problem areas.

5) No internal clipping (proper depth sorting)

Make sure no polygons in your object intersect any other polygons so that it will sort correctly against itself in the game.  Test in GUIApp by bringing up the Art Stats window (under the View menu).  (Note: split poly counter seems to be broken right now)

6) Good bumpmapping and smoothing

Check out your bumpmaps to be sure they have a satisfying amount of definition - if not, play with the bumpmap depth parameter (text property), and if the object is supposed to be smoothed be sure it is smoothing well.  Reasons why objects will currently not smooth: no bumpmap; bad UVW mapping; angles between faces at 90 degrees or higher (currently these objects just don’t smooth: we will be able to force these objects to have smoothing turned on, but it won’t look great); texture maps which inhibit the smoothing effect (the barrels are a good example of this: there is a seam where the map wraps around to meet itself, and a little too much dirt/shadowing painted into the map itself for the smoothing to look most effective).

7) Use only power of 2 texture maps and consult the log of mip-map usage

All the maps you submit with the object must have dimensions which are a power of 2.  If in any cases you can't get good visual results out of a map of these dimensions, Kyle's texture packing script will allow you to pack your non-power of 2 maps into power of 2 maps.  Spend some time becoming familiar with this script when it is released to give yourself the option.

You should analyze the mip-map usage of your object when you put it in a game scene as well.  Check your C:\JP2_PC directory for TextureUse.Txt after moving through the scene in the same way the player would.  This file shows you which size map is used most frequently for each of your textures (the column after texture size is percent used, and the third is number of times used).  This data may prove useful if you think you could reduce the texture's resolution, but it isn't always desirable to throw out a higher resolution texture just because it is only used ten percent of the time, if those ten percent are when the object is right in your face looking its best.  There will soon be an option in GUIApp to turn off the highest resolution texture on all the objects in a scene: you can use turn them on and off and see how much visual difference the highest resolution version really makes.

8) Do a quick test of magnets and physics definitions

(Read this part but keep it in the back of your mind until  text properties and magnet definition methods have been finalized)

Go into play mode to be sure your object is properly moveable or immovable, and also check out by playing with it any other physics definitions you've given it, like mass, density, or center of mass.  If it is a magneted object, be sure it breaks apart about as easily or hangs together as well as it is supposed to, and that all the pieces actually are connected together.  For compound physics objects such as buildings, be sure that all the parts which are supposed to be solid actually are, by checking the bones view and dropping other objects on it.

Asset Guidelines, Part III: Technical Appendix

Using the Groff Exporter

Groff Exporter Features:

· Non-mesh objects (cameras, lights, tape measures, etc) are ignored by the exporter, so you don't have to hide or delete them when exporting.

· Any object named with a leading exclamation point (!Terrain for instance) also gets ignored by the exporter.

· If you are exporting over the same file, and you don't change or add textures in your scene, you only have to quantize bitmaps once.  It only takes a few seconds to export just the geometry of even a very complex scene, so save yourself a lot of time and deselect "Quantize Bitmaps" if you are only making geometry changes. 

· New Groff Exporter radio buttons: Export all scene objects, Export selected objects, Export all visible objects.  Pick one of these buttons to control what actually gets exported.  Export selected is very handy even if you are only working with a small number of objects, because it lets you single out and export one of them without hiding or deleting anything, or switching to a different MAX file, and Export all visible is useful if you habitually hide objects you don't want to deal with but don't want to delete yet.

MAX warning with the Groff Exporter:

Because of MAX's tendency to look everywhere for maps, don't export to the same directory as your MAX file: MAX may decide to look for its maps in the Maps directory that the Groff Exporter just created, and find the quantized versions of all your maps!  Learn to use the MapInfo script tool to see where MAX is getting your maps from. Learn to use the Map Path Re-Mapper tool to adjust the directory MAX is using if necessary.

Moving .GRF files:

If you want to move a groff file you've made somewhere else, follow these steps: (assume you're using Test Scene.GRF).  Copy (or move) Test Scene.GRF to a new directory, make a folder there called Map, and copy into that folder the old Map\Test Scene folder.  If you are working with a scene that has terrain in it, there will also be a .trr and .aht file (which may have a completely different name than Test Scene) in the same directory as the groff, and these have to come along as well.  If your scene has audio and you want to keep it, you need to be sure that you copy or move the audio folder from the old location of the groff file, and copy or move the Test Scene.col collision file.  You don’t need to have these audio files – the groff will still work without them.

Advanced Groff Exporter Techniques

Making a new version of a scene quickly:

When you want to export another slightly different version of a scene (or a few objects), and you don't want to wait to re-quantize your bitmaps (or remake your mip-maps; see Using GuiApp, below), make a copy of the Maps folder from your old scene, and then, when you export, name your new groff file exactly the same as your new Maps folder (case is important), and make sure you turn off "Quantize Bitmaps" in the exporter dialogue - then, presto, in a few seconds or less you have a new file.

Adding bitmaps:

If you bring some new objects into your scene, or change textures on one of your objects, select just that object, and export it to the same name as before, making sure to turn off Create Groff File, and turn on Quantize Bitmaps.  This will quantize the new bitmaps only, and then you can export the whole scene without quantizing again.  Note that as detailed below, each quantization pass creates a new palette for the set of objects being quantized.  

A note about quantization:
Each time you quantize, all the maps being quantized into a single palette.  Since we will probably have four diffferent palettes in the game (terrain, vegetation, manmade/wooden and maybe manmade/metal), you can use the above technique to quantize the objects from your scene in four different groups for the best palette results.  If you are working with a scene, you should divide your objects into three groups and a terrain object group and do a final quantization pass for each group for accurate results.

Note that any/all terrain objects (TrnObj*) MUST be quantized into the same palette to avoid odd results - which means that if you add one terrain object you have to re-quantize all the terrain objects

Things that cause export problems, and how to fix them:

· Non-uniform scaling:  Most of the time objects which you've used the non-uniform scale tool on will export just fine, but they are not guaranteed to, so GroffExp will warn you.  Solve by doing a Reset Transform.  Avoid for now by using the Xform modifier instead of the scale tool.  The next version of GroffExp will be able to handle this.

· Different sized bumpmap: Bumpmaps and their associated texture maps have to be exactly the same size.  Fix by changing the size of one to match the other.

· Texture too large: We can't use any textures which are larger than 256x256 pixels.  

· Non-power of 2 texture maps: actually won't cause any problems that you will see errors or warnings about for the moment, but we want to supply all textures as power of 2 textures in order to efficiently pack them in memory in the game.  Kyle's texture packing script will allow you to take your non-power of 2 textures and put them into a power of 2 format.  See the Using Scripts appendix entry below.

· Object appears in wrong place in GUIApp: MAX did something to the object that GroffExp doesn't like when you were transforming it.  Using Reset Transform usually clears this up.  Load in the grid.grf from K:\Art\CommonGroffs to aid in checking placement.

· Geometry errors: Check for degenerate faces (script tool?).  Also, faces which occupy exactly the same position as other faces cause real problems in GUIApp, though currently GroffExp doesn't check for this.

Using GUIApp

Having exported your file successfully, you will now want to look at it in GUIApp.

GUIApp loading tips

Currently, and this will really only be noticeable if you load a groff with a lot of objects, the first time after you make a new groff (or quantize new bitmaps), GUIApp pauses during loading to make new mip-maps.  Bumpmap loading can take a long time in certain cases, too.  If GUIApp does not appear to be doing anything right after you tell it to load, it is not crashed.  Continue to wait.  Files have taken as long as 15-20 minutes to load up.  In most cases if there's an actual problem, GUIApp will assert during loading and tell you about it.

Useful GUIApp settings as of 9/9/97:

· Make sure to turn System Memory on (under Screen).

· If you are looking at only one or two objects at a time, you don't really need to use Image Cacheing.  It is off by default.

· If you click on the Set to Fog button under Edit>Background Properties, you will (currently) get a light blue background, which can be a slightly better background to test your objects against.

· To see how your bumpmap is affecting your object, you can turn off textures under Options>Textures, and just see the geometry of your object shaded by the bump map.  Very useful to see how well smoothing is working with your object.

· You should be able to run GUIApp in full screen, 16-bit color mode in some resolution.  If, when you pull down the Screen menu, you don't see any entries which end in x16 (like 640x480x16), then you need to install a newer version of DirectX and see if you get any more screen modes.

GUIApp key reference:

· Home takes you to the currently selected object (red crosshairs).

· Space switches the currently selected object.

· Arrow keys move forward/back left/right, PgUp and PgDown move you up and down, and Insert and Delete spin you left and right.

· Left drag on an object to move the object.  Shift makes up and down on the mouse move the object up and down, rather than forward and back.

· Right drag on an object to rotate the object.  Shift changes the axes of rotation.

· You can now select multiple objects by ctrl-clicking to add or remove objects to the group.  Unlike in MAX, though, once you have a group, you can click safely on any of the members to move the group without deselecting the group.  To deselect the whole group, click on any object not in the group.

Instancing warning:

If you tend to keep GUIApp running in the background while working with your objects, and you bring in another copy of an object which is named using the instancing convention (ends in -##), even if you exported a new version of the same object and the groff is different the new copy will instance off the version already existing in your scene, and you won't see your changes, which can be quite confusing.  The best bet is to keep quitting and restarting GUIApp if you are just working with a single object.

Advanced GUIApp: options.txt:
You can now play with the CLUT values, alpha blend colors, and fog colors, which influence how things get lit in GUIApp.  Altering these values is not recommended unless you are involved with scene creation, as on a single object basis you will not notice their overall effects enough to tell what you are doing.  Having an options.txt is also a convenient way to save your frequently used settings, like System Memory on and background color.  If would like to use one or experiment with changing lighting colors and have questions about how to do this, see Kyle or Rich. 

Coplanar Faces

Two triangles that share an edge and have surface normals that point EXACTLY the same direction are considered to be coplanar.  A good example of this is a box.  It has 6 sides, but 12 triangles.  Why?  Because each side contains two triangles.  For the case of a box, GUIApp will optimize each side into 1 polygon, so it renders 6 polygons rather than 12 triangles. 
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The left hand triangles are coplanar -  they exist on the same plane in space.  The right hand faces have been bent with respect to each other and their normals no longer point in the same direction.

Using Scripts

A much longer document detailing the use of all the scripts will also be available, but some of the more commonly needed scripts are outlined here.

Texture Packer: to be completed soon, stay tuned for another document when it is released.

MapInfo: this script will show you the full paths for texture maps, either all the texture maps in your file, or just the ones on the selected object (use the radio button to control this).  You must open MAXScript's Listener Window to see the information - click on "Open Listener" in the MAXScript interface panel.

Map Path Re-mapper: If you need to get an object's maps pointing somewhere else, use this script.  You can either set the map paths for all the objects selected, by making your selection, then clicking on the "Remap Selected" button, or you can do it one object at a time, by clicking on the empty button next to "Object:" and then selecting an object (either directly from your views, or through the Select Objects dialogue).  In either case, you will next be presented with a file window, where you browse until you find the directory you want.

Name Manager: This script can be very helpful when you are working with multi-part objects or entire scenes and need to change a lot of object names for some reason, perhaps to control instancing or to make their names more understandable.  Select all the objects you want to rename, and then pick an object type from the set of radio buttons, which will determine the starting letter of your new object name (it will be the first letter of the object type name, with the exception of Other, which will let you rename objects without adding any prefix).  Next, type in the name of the object in the prefix box.  If you want to add a number to the object name(s), click on the button marked "#" next to the prefix box - if you have a lot of objects selected, it will number them successively, from 0 on up.  You can use the Delimiters drop-down to add a symbol after the name and number, and if you want to add still more text or numbers after this, type in the Suffix box and/or click on the # button next to it.  Finally, if you want the object(s) to be instanced, click on the Instanced button.  Usually, you will just use a prefix name, the first # button, and the Instanced button, unless you are getting really fancy.

Units Conversion and Pixel/Unit Ratio: These two scripts do calculations for you which will be very helpful: Units Conversion lets you type in a value in the feet, inches, or meters box, and when you press enter, it updates the other boxes, showing you the value converted into the other units.  Pixel/Unit Ratio is useful when you are ensuring that a set of objects (or faces) have a roughly consistent texture resolution to quickly find out how many pixels per meter a face of your object has if you know how wide the face is and how many pixels across the texture map is: enter these values in the top boxes, and the bottom box will show you your texture map resolution in pixels per meter. If you use the spinner next to the Pixels per M box in conjunction with the Pixels and Meters radio buttons, you can change to some desired texture resolution, and see how that changes the necessary size of either the face/object or the texture map.

Scene Map Info: this script will check to be sure that all your maps and their associated bumpmaps or opacity maps are equal sizes, and check to see if your maps are power of 2 maps.  You can run it either on all your objects or just the currently selected ones, and when you click on Gather Data it opens a window where you type in the name of a text file to save the data into. When the script completes, find this file from the Windows Explorer and open it to see what was found. 

Trespasser Utilities:  This script has a bunch of cool buttons in it.  In most cases, they are self-explanatory: make a selection, and then click on a button.  In the case of the Find Object Dimensions script, you must first click on Pick Object, and then select an object.

Test Scene: This one quickly determines if you have some of the more common export-preventing problems with your object.  You can run it on your entire scene or just your currently selected objects.  Use the checkboxes to control what problems you want to test for.

The Solids model

Creating an object which can be used in the game requires a good understanding of the physics system which determines how the game will actually work.  Our physics system is based on two primary concepts: a solids model and 'magnets' which connect the box-shaped solids.  There is also a third concept, the bio-model, which allows dinosaurs to have a flexible skin which moves according to the physical limitations of a set of jointed, rigid bones (just like a real dinosaur, except we represent the bones somewhat more abstractly - no one builds a MAX model of the dinosaur's actual bones).  The bio-model will also allow our plants and tree branches to bend and flex like real plants.

Here is a bench - three solids magneted together define it.  Note how the solids don't perfectly match the legs of the bench - but if you break the bench apart, you never notice that there is any difference between their geometry and their physics.
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 Everything you build will get represented by either the solids model or bio-model.  For now, we'll concentrate on the solids model.  What this model does is represent everything in our game by using one or more solid box-shaped volumes.  Although the solids are currently limited to shapes you can make out of boxes, they are still quite flexible.  You can represent a cylindrical barrel very well with a solid box by changing the friction of the solid so that it rolls more than a solid box in the real world would roll, and although the solid doesn't conform exactly to the geometry of the barrel, it is close enough that the player will rarely, if ever, notice the difference.

Compound Objects

Complicated objects such as houses with windows or a truck get represented with multiple solids.  We call these compound objects.  In compound objects which can move, such as a truck, none of the solids may intersect with each other, but they may be positioned in any scale or orientation, so you can still come up with a good definition of the physical shape of the truck if you are a little clever with where you put your solids.  Objects which will never move, such as buildings, may have solids intersecting with other solids, which gives you a little bit more freedom when defining non-rectangular areas like roof beams and peaks.

Magnets

Objects with moving parts and compound objects are built of a bunch of solids connected by what we call magnets.  Unlike real magnets, ours don't have the common features you think of, such as polarity, nor do they even exist physically or visually for the player.  They are more like a special instruction to two solids to stick together, or to be able to rotate with respect to each other.  Magnets are created as objects in MAX, and their pivot point defines where the objects are connected together, where they will break apart if they can be broken apart, and where their axis of rotation is if the magnet allows movement.

Solids and magnets are the tools, but the key to good object construction is to apply these tools creatively.  Beyond the fact that moveable solids can't overlap, we also need to try to keep the overall number of solids we use in any object to a minimum, so optimizing the physics definition of an object is just as important as optimizing the polygon count and texture size.  There is a fine line to be walked, however, between minimizing the amount of solids used and compromising the reality of the object: use the golden rule, and if the object seems to need a lot of solids to give it a correct physical presence, consider simplifying it visually to allow it to be simplified physically.
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The jeep has been given a really simple definition - if we wanted to spare a few more solids, we could use three for each mudflap, and have the wheel defined more closely.  The cage is of note because all the bars you see are actually just part of a transparently mapped polygon - your geometry doesn't have to match your solids model in all cases (note that this cage probably still uses a few too many solids, but could be optimized to have fewer, but larger bars).

Movable and breakable objects

Moveable and breakable objects require special consideration when building: if you construct something out of planks of wood or pieces of lumber, for instance, then not only must each piece of lumber be a separate object, but you also may not join them at an angle, either, because then it would be impossible to get a solids box which accurately matched the geometry of each beam without having them overlap.

This overview should get you going on understanding the interplay between object geometry and physics definition, but as you are constructing objects, you should definitely consult the designers and engineers as you go if you have questions and concerns about applying solids to your object.

Design Documentation

Be sure to check all the appropriate sketches and documentation from the design directories while you are making your object.  All design documents for Trespasser are located on J:\, in the Design folder.  It may seem a bit overwhelming at first, so here is a simple guide to finding what you need from the design directories:

1) \Design
The top level directory only has one file which you will want to consult while creating objects: It is the game walkthrough, currently called Walkthrough 8-27-97.doc (the name may change slightly, but will always begin with Walkthrough).  This is only a rough outline of the puzzles and gameplay in each area of the game, but it can be useful to get a sense of the place your object fits into.


2) \maps
The crucial directory under Design is \maps.  Here, you will find a folder for each of the eleven different areas in the game (Beach, Jungle Road, Plantation House, Industrial Jungle, InGen Town, Plains, Pine Valley, Shore, InGen Lab, Ascent, and Summit). 


3) Area folders
Within each area's folder you will find documents describing in detail all the gameplay-critical objects and puzzles in the area, maps and sketches to show objects and important parts of the terrain, and directories with photo reference to consult while building objects.  Some areas have a lot of sub-areas and have further folders within them to break up the information further.  You should be sure to check all the relevant documents and sketches in all the folders under the main area directory, with the exception of any titled "Old" or "Archive," which would be earlier versions of designs.  If you seem to be missing critical information on an object, consult with a designer to be sure that you've seen all the relevant documents and to get more precise detail.


Mip-mapping

Mip-mapping is a process by which textures are automatically replaced with lower-resolution versions as they get further away from the camera.  Mip stands for “most important point” because the lower-resolution versions of the source textures being mip-mapped are reduced in such away that their most important visual features are retained.  Mip-mapping does two things: first, it helps objects look better when they are further away from you, because without mip-mapping the results of having the renderer scale a high res texture to a very small resolution (especially if the source texture has a lot of fine detail to it, like single pixel wide lines), can be fairly unsatisfactory.   Second, because we will be able to dynamically load individual mip levels, we can reduce the total amount of memory an object will take up when it is far away from the player.  For the most part, the highest resolution versions of your textures will only be displayed when the player is very close to an object, so if the object is a building with 4 megs of textures, it may only need one megabyte or a quarter megabyte or even less (each lower mip level is one quarter the size of the previous level) at most times, until then player walks right up to it, at which point all the surrounding textures will be reduced to lower mip levels.

Creating an Orchard

Creating an orchard of many objects is a really good way of seeing how your particular object performs when there are hundreds of them in the scene at once. Here is a quick set of steps to create one...

1. In the Top view, select you object or group of objects that you want to create an orchard out of.

2. While holding the Shift key down, move your object to the right, creating a copy.

3. When you get the Clone Options dialog, set the spinner number to ~10. The result is that you have an array of as many objects as you specified.

4. Now select that entire array of objects and repeat step #2, but move them up instead of right. The result is that you have an 'orchard' of objects. When you export your scene and look at it in the GUIApp, you will be able to see how efficient (or inefficient) your object is.
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